
LIGHTROOM CLASSIC 7.2
The latest version of Lightroom Classic gets a serious  
performance boost, plus several new features. p20

UNDER THE LOUPE
If you’re thinking about moving from Classic to CC, here are all the 
things you need to consider before migrating your catalog. p40
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All my best, 
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Okay, we went from it being a scary time to be a Lightroom 

“Classic” user to being a really cool time now that Adobe 

has been fairly rapidly improving Classic. The 7.2 update 

that was just released is the third update to Classic since 

Lightroom CC (the cloud-storage version) was introduced 

back in October last year. I know that a lot of worried 

people are breathing a sigh of relief, as we see that Adobe 

hasn’t turned its back on millions of Classic users, and for 

that, we’re very grateful. 

This is actually a pretty interesting time in the evolution of 

the Lightroom ecosystem in which there are a lot of moving 

parts. You have Lightroom Classic (Lightroom 6 is still out 

there, though it just got what will be its final maintenance 

update); Lightroom CC (the cloud-storage version); the  

mobile version, which is a bit different depending on which 

device (tablet or phone) and which platform (iOS or  

Android) you’re using; and then there’s Lightroom Web 

on top of all this. By the way, the Android tablet version of 

Lightroom CC is different than the Android phone version, 

which is different than the iPhone version, which are all  

different from the desktop versions. I don’t have any 

idea how the Lightroom development teams keep this all 

straight (or get any sleep at night working on all of these 

versions simultaneously). All that being said, if you compare 

the latest version of Lightroom CC for desktop to Light-

room Web and the iOS version of Lightroom CC, you’ll see 

them all starting to converge and share a similar look and 

workflow, so it’s all starting to make sense. 

What I’m hoping to see soon: While we just got some 

important new updates for Lightroom Classic (and the 

speed boost we’ve been dying for), I know Adobe has its 

hands full adding missing features to Lightroom CC (the 

cloud version). And yes, it’s driving us educators a bit crazy 

trying to make sure that our students know which version 

of Lightroom we’re talking about when we’re teaching. 

There’s a reason why people are saying the “CC” in Light-

room CC stands for “Creates Confusion.” 

Anyway, here’s what I’d love to see Adobe do next to 

bring Classic more closely into the fold. I simply want them 

to give Classic the modern look of Lightroom CC’s panels. 

It wouldn’t require anything but a fresh coat of paint to 

the Classic user interface. I’m talking about the look and 

feel of the panels and the sliders. In CC they look very 

modern (while still having the same names and function-

ality), but in Classic they look pretty much like they did 

11 years ago. Making that little change would help make 

Classic feel new again. Unless Adobe’s idea is to purposely 

keep it looking old (and I hope that’s not the case), a new 

look would go with what we’re seeing being added  

feature-wise in all of these recent Classic updates. 

The best is yet to come: As soon as Adobe launches  

an update, like they just did with Lightroom 7.2, they’re  

on to the next round of updates. While I can’t tell you 

what’s coming, I can tell you it’s so awesome that it will 

change the way we all work (for the better), and you’ll 

be so happy to be part of the evolution of this constantly 

growing and changing Lightroom ecosystem. (By the way, 

to learn more about the 7.2 update, turn to page 20 in 

this issue.) 

One more thing: I released a new class a few weeks 

ago called Mastering the Natural Light Portrait, and I’m 

very grateful to see how well it’s been received by our 

members. I bring this up because now there’s a part 2, 

which is processing the images I created in part 1 (the 

shooting part) using Lightroom Classic and Photoshop CC,  

and I hope you’ll give it a watch when you get a chance. 

It’s called Mastering the Natural Light Portrait, Part 2: 
Post Processing (and yes, I’ve been nominated for the 

“Obvious Title Award” once again). ;-) 

Thanks for being a member, and here’s to what’s already 

been a great year for Lightroom users.

https://members.kelbyone.com/course/skelby-natural-light-portrait/
https://members.kelbyone.com/course/skelby-natural-light-portrait-post/
https://members.kelbyone.com/course/skelby-natural-light-portrait-post/


ARE YOU TAKING ADVANTAGE OF THE DISCOUNTS 
ON YOUR MEMBERS-ONLY DISCOUNT PAGE?

Lightroom Magazine

Benefit Spotlight

 L
IG

H
T

R
O

O
M

 M
A

G
A

Z
IN

E
 ›

 I
S

S
U

E
 3

8

8

Did you even know these discounts existed? If not, stop 

what you’re doing right now and explore how much 

money you could be saving on everything from camera 

gear to office supplies. We have special discounts from 

B&H, Apple, Mpix, Triple Scoop Music, Tether Tools, 

and many more—even discounts on hotels and rental 

cars. That’s the power of being part of an organization 

such as KelbyOne. We negotiate special deals just for 

our members. Some members have even saved enough 

money through our discount program to make their 

cost of membership practically free. 

So what are you waiting for? Log in now to see how 

much you can save, especially if you’re about to invest in 

some new camera gear or Photoshop plug-ins. n

Discuss this Issue

https://kelbyone.com/discount/
http://community.kelbyone.com/t/lightroom-magazine-issue-38/
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Wed. May 30th  |  In-Depth Workshops (separate registration & fee required),  
Meet-Up, and First Time Attendees Orientation 

Thurs. May 31st  |  Keynote, Classes, Portfolio Reviews, Partner Pavilion, Get Ready to Go Pro,  
Dinner with a Stranger, and After-Hours Party

Fri. June 1st  |  Classes, Photo Shootout, Live Natural Light Shoots, Partner Pavilion,  
Midnight Madness, and An Evening with Jeremy Cowart, and 10 Things Luminar Can Add to Your Lightroom/Photoshop Workflow

Sat. June 2nd  |  Classes, Guru Awards & Wrap-Up Ceremony

The Creative Conference for 
People Just Like You!

It’s where an exciting mix of Photoshop users, Lightroom fanatics, photographers of all types, graphic 

designers, and people from all over who use Adobe’s Creative Cloud apps come to leave the world behind 

to totally immerse themselves in three days of incredible in-depth training, creative inspiration, and fun. It’s 

about losing yourself in a flood of new ideas, new techniques, and new, faster, better ways to do things. 

Photoshop World is jam-packed with hands-on training, fun events, networking, and opportunities to interact and 

meet the best instructors in the photography and design community.  With six specialized tracks each day and 

over 100 classes and live shoots, we have the right training for you, regardless of your skill level. Photoshop 

World 2018 will be held in the Hyatt Regency Orlando, Convention Level from May 31st- June 2nd. We  

guarantee this is the most fun you’ll have learning, but don’t take our word for it. Visit photoshopworld.com  

to see what our attendees have to say.

View all the Photoshop World 2018 highlights  
at photoshopworld.com/events

Three Days of Non-stop Photoshop,  
Lightroom and Photography Training

Adobe, the Adobe logo, Photoshop, LIghtroom, Creative Cloud are all registered trademarks of Adobe Systems, Incorporated. 

Photoshop World

http://photoshopworld.com
http://photoshopworld.com/events


View all the Photoshop World 2018 instructors  
at photoshopworld.com/instructors

Instructors, classes, and class materials may change without prior notice. Visit www.Photoshopworld.com for the latest schedule and information

     Scott Kelby                     Joe McNally                  Peter Hurley                 Jeremy Cowart             Moose Peterson

Matt Kloskowski       Roberto Valenzuela              Glyn Dewis                     Dave Black                     Kalyee Greer 

     Tim Wallace                 Serge Ramelli                   Terry White                 Kristina Sherk                   Rob Sylvan

Instructors
Get Ready to Learn From the Best

We all know the difference a great teacher can make and that’s why only the world’s best instructors are invited  

to speak at Photoshop World. Our instructors take the stage to share the latest techniques, tips, and time saving 

tricks. Best of all, we’ve made sure to include time for you to interact with them after each class and at events. 

Don’t miss out on your chance to meet your favorite photography/Photoshop/Lightroom instructor.

http://photoshopworld.com/instructors
http://photoshopworld.com


After-Hours Party

Midnight Madness

In-Depth Workshops

Keynote Address

Live Natural Light ShootsGuru Awards



Customize Your Learning  Experience

View the entire Photoshop World 2018 workshops' schedule 
at photoshopworld.com/workshops

With six specialized tracks each day and over 100 classes and live shoots, we have the right training for you, regard-
less of your skill level. Create you own custom training experience by following one specific track each day or skipping 
between multiple tracks. We have color-coded each track for easy identification so that you can spend more time 
learning and less time roaming the halls. 

IN-DEPTH WORKSHOPS (05.30.18) SCHEDULE

Come the day before the conference kicks off for our optional in-depth pre-conference workshops. These intensive 
workshops provide a deep dive into the topics you want to learn most with small class sizes, live shoots, and hands-
on training. Pre-purchase is advised. 

Characters on Location  | Joe McNally

Cityscape Retouching: A Live Shoot  |  Serge Ramelli 

Train your Eye to SEE and CREATE  
Better Poses  |  Lindsay Adler 

Lightpainting  |  Dave Black 

Overcoming The Challenges of Location Shoots  
Frank Doorhof 

Photo Safari  |  Moose Peterson

Photoshop Essentials for Beginners  |  Dave Cross

Photograph Like a Thief: From Concept to Print  
& Everything Between  |  Glyn Dewis

Building Your Portfolio  |  Stella Kramer

Pro Techniques for Lighting Automobiles!  
A Live Shoot  | Tim Wallace

http://photoshopworld.com/schedule


Moose  
Peterson

Rick  
Sammon

Dave  
Cross

Jesús 
Ramirez

Tim 
Wallace

Matt
Kloskowski

Modern Day Wildlife Photography  |  Photography

Adding Impact to In-Camera Images  |  Photoshop Effects

Selections & Masks Demystified  |  Photoshop Essentials 

Mastering Photoshop Blending Modes  |  Graphic Design

Stock Photography: How to Shoot It & Sell It  |  Business/Career

Luminosity Mask Basics in Lightroom & Photoshop  |  Lightroom

View the entire Photoshop World 2018 workshops' schedule 
at photoshopworld.com/workshops

Kim Griffen  |  PSW Guru Winner

DAY 1 (05.31.18) SCHEDULE

Lindsay  
Adler

Glyn  
Dewis

Bryan O’Neal  
Hughes

Dave  
Cross

Stella  
Kramer

Scott 
Kelby

High Impact Images: Create Photos that WOW  |  Photography 

Photoshop Lighting Effects for Photographers  |  Photoshop Effects

A Modern Photo Restoration  |  Photoshop Essentials

Intro to Illustrator  |  Graphic Design

50 Things You Need to Know to Succeed, Part 1  |  Business/Career 

Simplified Lightroom (Classic) Image Management System  |  Lightroom
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The Art Behind the Headshot–Top 10 Tips  |  Photography

Photo Styling with Photoshop Color Lookup Tables  |  Photoshop Effects

Digital Darkroom Essentials: Landscape  |  Photoshop Essentials

Getting Started with InDesign  |  Graphic Design

50 Things You Need to Know to Succeed, Part 2  |  Business/Career

Using Lightroom with Photoshop: When & Why?  |  Lightroom
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View the entire Photoshop World 2018 schedule  
at photoshopworld.com/schedule

DAY 2 (06.1.18) SCHEDULE

Kaylee 
Greer

Dave 
Black

Mark 
Heaps

Dave 
Cross

Lindsay 
Adler

Matt 
Kloskowski

The Secrets to Creating the Best Dog Photos   |   Photography

SPORTS Action High Speed Sync FLASH   |   Lighting/Flash

Digital Color & Tone Fundamentals  |  Photoshop Advanced Techniques 

The Power of Using Photoshop, Illustrator & InDesign Together  |  Graphic Design

Plan, Shoot & Publish a Fashion Editorial  |  Motivation/Inspiration

Lightroom Mobile: Landscape & Travel Photographers  |   Lightroom

Peter
Hurley

Lindsay 
Adler

Julieanne 
Kost

Corey 
Barker

Kaylee
Greer

Serge 
Ramelli

Top 10 Headshot Blunders  |   Photography

 Portraiture as a Work of Art: A Live Shoot  |  Lighting/Flash

Advanced Photoshop Tips & Tricks  |  Photoshop Advanced Techniques

Improv Photoshop & Illustrator Hour  |  Graphic Design

Live Your Dream Career!   |   Motivation/Inspiration 

Cityscape Master Class   |  Lightroom

Tracy 
Sweeney

Frank 
Doorhof

Lindsay 
Adler

Dave 
Cross

Tim 
Wallace

Rob 
Sylvan

Creative Newborns: Posing, Styling & Workflow  |  Photography

Creating Magic with Less: A Live Shoot  |  Lighting/Flash

Color Grading: For Mood & Impact  |  Photoshop Advanced Techniques

The Power of Photoshop Presets  |  Graphic Design

‘Dude Nobody Sees My Work’  |   Motivation/Inspiration 

Lightroom Mobile: Creating Your Own Looks  |  Lightroom
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Landscape Photography: Beyond Sticks & Stumps  |  Photography

Lightpainting: Fun in the Dark  |  Lighting/Flash

Making Realistic Composites in Photoshop  |  Photoshop Advanced Techniques

Create & Update Your Portfolio with Adobe CC  |  Graphic Design

A Year in the Life of a Photographer  |  Motivation/Inspiration 

Everyday Portrait Retouching in Lightroom   |  Lightroom

Airshows: Get Beyond the Crowd Shot  |  Photography

Mixing it Up with Radio TTL - Big & Small Flash Together   |  Lighting/Flash

Retro Down & Dirty Tricks   |  Photoshop Advanced Techniques

Get Inspired by Graphic Design   |   Graphic Design

Creative Practice: The Tortoise & The Hare  |  Motivation/Inspiration 

Lightroom’s Client Proofing & Sharing Online   |  Lightroom

Attend conference sessions in any track and move between them as you like. Instructors, classes, and class materials may change without prior notice. 

Visit www.Photoshopworld.com for the latest schedule and information.
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The Right Stuff: A Sports Shooters Guide  |  Photography

Portrait Lighting is Easy, Trust Me!   |   Lighting/Flash

The Art of Magazine—Quality Skin Retouching  |   Photoshop Advanced Techniques 

How to Design Really Effective Ads!   |  Graphic Design

The Joyful Photographer: Run a Successful Child Photography Business  |  Motivation/Inspiration

Black & White: Today & Yesterday  |   Lightroom
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DAY 3 (06.2.18) SCHEDULE

Glyn
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Wojtczak

Terry 
White

Photoshop Power Hour   |  Photoshop for Photographers

Creating 3D Composites in Photoshop    |  Photoshop Compositing

Luminar: Filling the Void of Nik   |  Software/Plug-ins 

Illustrator Tips & Tricks   |  Graphic Design

DSLR Video Basics   |  Video for Photographers

Lightroom: Beyond Image Management   |  Lightroom

Tricks & Fixes to Make Photoshop Fun    |  Photoshop for Photographers

Compositing: Don't Get Stuck, Get Creating!    |  Photoshop Compositing

Batch Portrait Retouching with Perfectly Clear V3 & Lightroom   |  Software/Plug-ins 

Ten Tips & Tricks for InDesign   |  Graphic Design

Increase Your Photography Sales with Video   |  Video for Photographers

Making Awesome Prints in Lightroom Classic   |  Lightroom

A Complete Photographer's Guide to Photoshop   |  Photoshop for Photographers

Compositing Techniques   |   Photoshop Compositing

Start of Finish Workflow with On1 Photo Raw   |  Software/Plug-ins 

Intro to Adobe Muse CC   |  Graphic Design

DSLR Interviews: Creating an Impactful Story   |  Video for Photographers

Presets: How to Speed Up Your Workflow   |  Lightroom
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Images courtesy of Brad Moore, Rob Foldy, Nick Pedersen, Scott Kelby, Don Clark, Kevin Newsome, Kim Griifen and Scharad Lighbourne.

Don Clark  |  PSW Guru Winner



To Register or Inquire About Discounts/Group Pricing 
Visit photoshopworld.com/pricing or Call 1.800.201.7323

Hyatt Regency Orlando  |  9801 International Drive, Orlando, FL 32819

Our home for Photoshop World is the beautiful Hyatt Regency Orlando Convention Center conveniently 

located on International Drive. Placed within walking distance to Pointe Orlando with dozens of beauti-

ful shops, exciting eateries, and nightclubs, it’s the ideal location for a conference. Best of all, The Hyatt 

Regency Orlando is our host hotel too!

Special Event Rate Per Night: $159 plus resort fee, current Orange County room tax of 13.5% (subject to change). 

To reserve your room visit photoshopworld.com/travel. Resort fee includes complimentary self-parking for two  

cars/per room, in-room Wi-Fi connection, fitness center access (fitness classes, pool activities, and bike rental),  

10% off spa treatments and merchandise, (2) I-Ride Trolley tickets, local and toll free (800) calls, free faxes, and  

(2) 16.9oz bottles of water per day.

Stay Where the Action Is!

host hotel

Make your Photoshop World experience EXTRA special with one of our fun events. Whether you enjoy learning  

or connecting with other artists we have the right option for you. Our Pre-Con Workshops provide you with hands-

on learning while the After Hours Party lets you cut loose with other creatives! Want the best of both worlds? Try 

the Pro Pass, which gets you front row seating in any Track Class you attend, some Photoshop World gear, and  

a bookstore coupon for $25. PLUS your Pro Pass includes an After Hours Party Ticket. Looking for something a  

little more personal and one-on-one? Try the Portfolio Reviews. They’re an invaluable opportunity to have an  

in-depth review with candid appraisals, business insights, and practical advice all catered to you and your work! 

It’s All About the Extras 

http://photoshopworld.com/pricing
https://photoshopworld.com/travel


Lightroom Feature  |  BY ROB SYLVAN

With a continued emphasis on improving overall performance, 

Adobe has released the next update to Lightroom Classic CC 

(7.2). Not only does this update bring speed enhancements, 

but it also adds several new useful features, plus support for 

new camera models and lens profiles. 

A CLOSER LOOK  
AT THE LIGHTROOM 
CLASSIC CC 7.2 UPDATE
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Improved Performance 
The really big news is the additional improvements to 

performance. Windows users and high-performance 

machines should see the largest speed gains. The best set 

of third-party performance testing I’ve seen for the new 

update looks very promising. Specifically, you should see:

• Faster import (both regular and Auto Import) 

• Faster preview rendering 

• Faster export 

• Faster merging to panorama and HDR 

• Faster rendering in Develop when making adjustments 

• No loss of performance over time 

Note: If have any problems after installing this update, 

head over to the Lightroom Community forum and share 

your experience. Adobe has worked with a lot of customers 

to resolve reported issues. 

This update isn’t all bug fixes, new camera support, and 

performance enhancements (though, we’re really grateful 

for them). There are also a number of new features that you 

may find pretty useful. 

Search Folders Panel 
You’ll appreciate this new feature if you have a long list of 

folders and you’re tired of scrolling up and down through 

them. As we’ve had in the Collections panel, there’s now  

a field at the top of the Folders panel that allows you  

to type in a few characters and have Lightroom filter the 

contents of the panel based on those characters. This 

will be a huge timesaver for me. (Note: After clearing the 

search, it can take a moment for Lightroom to redisplay 

the contents of the panel.) 

Lightroom Magazine

Favorite Folders 
There’s also a new way to get easy access to a folder that 

can be found across all modules. Now you can mark a 

folder as a favorite, and once marked, it’s added to the 

Favorite Sources, which is accessible from the drop-down 

menu above the Filmstrip. First, Right-click the folder you 

want to mark (or unmark) as a favorite. 

https://www.pugetsystems.com/labs/articles/Lightroom-Classic-CC-Version-7-2-Performance-1110/
https://feedback.photoshop.com/photoshop_family/categories/photoshop_family_photoshop_lightroom
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Collections from Folders 
Another helpful addition to the Folders panel is a new way 

to create collections, and even collection set structures, from 

your folders. These new options are found in the contextual 

menu when you Right-click a folder in the Folders panel.

In the above example, I marked three folders as favor-

ites, and then filtered on Favorites Folders. By Right-clicking 

the parent folder, I accessed the contextual menu and chose  

Create Collection Set “2015,” which opened the Create  

Collection Set dialog. From there, you can rename the collec-

tion set and even add it to an existing collection set (if desired).  

I added a more meaningful name to the date and added it 

to my Travel collection set. 

This results in the parent folder becoming the collection 

set, and its subfolders are all made into regular collections. 

This could be a real timesaver for anyone transitioning from a 

folder structure to a collection structure. You can also select 

multiple folders in the Folders panel, invoke the contextual 

menu, and choose Create Collections from Selected Folders 

to convert each selected folder into an individual collection. 

Collection from Map Pin 
For Map module fans, you can now easily create a collection 

from a location on the map. Just Right-click the map pin, 

and choose Create Collection from the contextual menu. 

This invokes the usual Create Collection dialog where you 

can give it a name, add it to a collection set, and even mark 

it to sync with CC, or set it as the target collection. 

That folder will be marked with a star icon and added to 

Favorite Sources.

You can also filter on favorite folders in the Folders panel 

using the new search field set to Favorite Folders. 

Lightroom Magazine
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Filter on Edit State 
A small, but potentially useful addition to the Library Filter is 

the ability to filter on Edited vs. Unedited. Click on Metadata 

in the Filter Bar, and change one of the columns to Edit. 

You’ll see how many photos in the current source are edited 

or unedited (see image above). This could be good to make 

sure all photos have been edited before export. 

There’s also a simple toggle to filter edited or unedited 

photos under the Attribute section of the Library Filter, as 

well as above the Filmstrip. 

New Camera Support
As with every new update, Adobe has also added support 

for RAW files from new cameras. Here are the cameras that 

have been added:

• Fujifilm X-A5 

• Fujifilm X-A20 

• Panasonic LUMIX DC-GF10 (DC-GF90) 

• Panasonic LUMIX DC-GH5S 

A number of new lens profiles have also been added, and 

the full list of supported lenses is maintained by Adobe. 

Enjoy the update! n

This article was originally published in LightroomKillerTips 

.com on February 13, 2018, the day Adobe announced the 

7.2 update.—Ed. 

ALL IMAGES BY ROB SYLVAN
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https://helpx.adobe.com/camera-raw/kb/supported-lenses.html
https://lightroomkillertips.com/lightroom-classic-7-2-update/
https://lightroomkillertips.com/lightroom-classic-7-2-update/
http://robsylvan.com
http://community.kelbyone.com/t/lightroom-magazine-issue-38/


Nothing sums up the majesty of Venice better than the Grand 

Canal, which is the main canal artery that snakes through the 

center of the city. The view you see here was taken from  

the Rialto Bridge looking northwards toward the Cannaregio 

district. Now, the Grand Canal is normally a very busy place 

filled with vaporetto water buses, taxis, and barges, but I just 

happened to capture this photograph when the only boats 

visible were a few traditional gondolas.

A VIEW FROM THE 
RIALTO BRIDGE

Developing the Shot | BY MARTIN EVENING



It’s one of my favorite photographs from 

my trip to Venice because of its timeless 

appearance (apart from the post-Renais-

sance satellite dish that you can see in the 

foreground in Step 8). Incidentally, you 

can also get a great view of the Grand 

Canal from the Ponte dell’Accademia; 

however, I found the wooden bridge 

tends to vibrate quite a bit when it’s busy 

with tourists, so there’s no point in using 

a tripod. 

I took this photograph using a Sony 

A7R camera with a 24–70mm zoom lens 

at a 35mm lens setting. I handheld the 

camera, using the bridge balcony for sup-

port, and shot about a dozen exposures 

over a couple of minutes as I explored 

viewpoints from different parts of the bridge. I like the bal-

ance here between the different elements within this scene. 

While I used the Graduated Filter tool in Lightroom to 

lighten the foreground, I did so with restraint. Without 

any tone correction, the gondola boats in the foreground 

would have appeared in silhouette. I therefore used carefully 

controlled amounts of locally applied Exposure and Shadows 

adjustments to bring out the shadow detail in those areas, 

but without overdoing it to the point where the exposure 

balance might look fake. One of the things that helped here 

was the use of the new Range Mask control in Lightroom 

Classic CC, which I explain in more detail below. 

The Steps 
Here are the steps I used to process this image. 

Step One: To begin, I went to the Basic panel 

where I adjusted the Exposure slider to lighten 

the image, and also added a touch of Contrast. 

I dragged the Highlights slider to the left to 

ensure the highlight detail in the buildings 

was preserved, and dragged the Shadows 

slider to the right to lighten the Shadows  

a little. I then held down the Shift key as  

I double-clicked the Whites slider to auto-set 

the white clipping point. 

Step Two: Next, I adjusted the white balance by 

going to the preset menu, where I selected the 

Daylight white balance setting. In the Presence 

section of the Basic panel, I applied a +15 Clar-

ity adjustment. This helped bring out the texture 

in the buildings. I also applied a +37 Vibrance 

adjustment to boost the color saturation. 
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Step Three: In this step I made 

sure the Enable Profile Correc-

tions box was checked in the 

Lens Corrections panel. This 

applied a profiled lens correc-

tion to the image to correct for 

geometric distortion and lens 

vignetting. I also checked the 

Remove Chromatic Aberration 

box to automatically remove any 

fringing. I normally have these 

two options applied by default 

for all RAW photos I import into 

my Lightroom catalog. 

Step Four: Over in the Trans-

form panel, I clicked each of 

the auto-calculated Upright 

buttons in turn to see which 

might achieve the optimum 

perspective correction. In this 

instance, I found the Vertical 

Upright adjustment applied 

the most effective perspective 

correction adjustment. 
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Step Five: I felt this photograph 

suited to being cropped top and 

bottom to give it a more cine-

matic look. To do this, I selected 

the Crop Overlay tool (R) and 

dragged the top and bot-

tom handles inward. You can 

use the Enter or Return key to 

apply a crop. Or, you can simply 

use the R key to exit the Crop  

Overlay mode. 

Step Six: I was now ready to fine-tune the light and shade. To start, I selected the 

Graduated Filter tool (M), clicked in the sky, and dragged downward to add an Expo-

sure darkening adjustment. To refine the Graduated Filter effect, I chose Color in the 

Range Mask option, selected the Color Range Selector eyedropper tool located to the 

left of the Range Mask drop-down menu, and clicked in the sky to sample a blue color. 

This restricted the Graduated Filter effect to the sky color area only. K
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Step Seven: With the Graduated Filter tool still selected, I added a second filter adjust-

ment to the bottom of the photograph, applying a positive Exposure and Shadows 

adjustment. As before, I set Range Mask to Color mode and used the Color Range 

Selector eyedropper tool (with the Shift key held down) to sample colors from four 

areas of the canal to restrict the lightening adjustment mainly to the canal only. 

Step Eight: Next, I selected the Radial Filter tool (Shift-M) and added a filter adjust-

ment to the gondola shown here in which I lightened this area using the Exposure 

and the Shadows sliders. I then Right-clicked the filter adjustment pin and selected 

Duplicate from the contextual menu. 
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Step Nine: I dragged the duplicate Radial Filter adjustment across to the gondola on 

the left and adjusted the shape of the Radial Filter to match the size of the gondola. 

Finally, I added a new Radial Filter adjustment to the bottom-right corner and applied 

a cool Temp adjustment to make the water in this part of the canal appear more blue 

in color. I also decreased its Saturation. 

Range Masking 
New to Lightroom Classic CC are the Color and Luminance Range Mask controls. The 

Range Mask options are located at the bottom of the Adjustment Brush, Graduated 

Filter, and Radial Filter panels. Here’s how it works: If you apply a localized adjustment, 

you can add a mask to the localized adjustment based on a sampled color by first 

selecting the Color option in the Range Mask drop-down menu. Then, click on the 

Color Range Selector eyedropper tool next to the Range Mask drop-down menu. With 

a single click, you can restrict the Color Range Mask area based on a sampled color, 

such as a blue sky. 

The Amount slider can then be used to adjust the depth of the Color Range Mask 

selection. Dragging the slider to the left narrows the range, while dragging to the right 

widens it, but you’ll notice how the Color Range Mask selection becomes smoother 

and more diffuse as you do this. For more precise masking, a lower Amount setting is 

best. To preview a Color Range Mask, you can hold down the Option (PC: Alt) key as 

you drag the Amount slider to see a temporary black-and-white mask preview. 

To refine a Color Range Mask selection, you can click again to sample a new color, 

or you can marquee drag to make a broader color range selection. To add more 

sample points, click or drag again with the Shift key held down. By doing this you 

can sample up to five color points; but if you exceed that number, the oldest sample 
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point will be removed. To manu-

ally remove a sample point, hold 

the Option (PC: Alt) key to turn 

your cursor into a pair of scissors, 

and click the point you want to 

remove. To exit the Color Range 

Selector tool, click the tool but-

ton again, or press the Esc key. 

The accompanying screen 

cap tures show the steps I went 

through to add a Graduated 

Filter effect to darken the sky 

and how I used the Range Mask 

in Color mode to edit the filter 

adjustment. Here, I selected 

the Color Range Selector tool  

and marquee-dragged to 

sample a range of blue sky 

colors. I then modified the 

Amount slider accordingly 

so the filter adjustment only 

affected the sky colors. n

ALL IMAGES BY MARTIN EVENING
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https://www.martinevening.com/index
http://community.kelbyone.com/t/lightroom-magazine-issue-38/


|   KELBYONE.COM   |   #KELBYONEBOOKS

HANDS UP IF YOU WANT TO LOVE YOUR FLASH

HANDS DOWN,  
THIS IS THE BOOK 

THAT WILL  
GET YOU THERE

Standing in front of a room packed with 360 photographers at his seminar, Scott asked for a show of hands:  
“How many of you own some kind of an off-camera flash? A Nikon, Canon, Yongnuo, etc.?” About 340 hands went up.  
“Okay, I have one more question, but before you raise your hand, I want you to really think about your answer.  

Let’s see a show of hands—how many of you love using your off-camera flash?” Out of those 360 people, just four  
people raised their hands. He was stunned. That’s why this book was created—to help you finally fall in love with  
your flash—and the best news is, it’s way easier than you’d think. It’s time to fall truly head-over-heels in love with  

your flash, so you can start creating the type of images with your flash that you’ve always dreamed of.

http://rockynook.com/shop/photography/the-flash-book/
https://www.amazon.com/Flash-Book-hopelessly-finally-taking/dp/1681982749/ref=sr_1_25?s=books&ie=UTF8&qid=1509463304&sr=1-25&refinements=p_27%3AScott+Kelby
https://kelbyone.com/


Lightroom Laboratory | BY SERGE RAMELLI

I love to travel, and my destinations are often inspired by  

other photographers. One day I saw a photo of Big Sur;  

to be more precise, it was a photo of McWay Falls in Big Sur. 

I immediately added it to my bucket list of places to photo-

graph. The day I went, I felt like the luckiest man on earth.  

I had the most magnificent sunset ever; it really embraced  

the beauty of this place and created a magical moment to 

witness and photograph. Here are all the steps I went through 

to get the result above. 

HOW TO SHOOT 
AND RETOUCH  
A PANORAMA
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Step One: First, let’s take look at what I went 

through to find the right composi tion. When 

I arrived, the light was okay but not crazy; 

the sun was on the far right and not on the 

waterfall at all. I tried taking six photos to 

create a panorama: three across the top of 

the scene and then three across the bottom. 

Here’s the result from my first attempt. 

Step Two: Then I waited 10 minutes and the 

light changed; it started to light up the water-

fall. I still wanted to make a panorama, but in 

my second attempt, I lost the frame-within-a-

frame composition, and it didn’t turn out the 

way I wanted. 

Step Three: Finally, I moved a bit more to the 

right, and the light started to be really amazing, 

with some magenta in the sky (my favorite). 

Determined to do a panorama with the frame-

within-a-frame composition, I took four photos: 

right, left, down, and then back to the right. 

Here’s the final edited image of this last attempt. 

Step Four: This is one of my favorite photos  

of all time! So, let me share with you my secret 

to developing this photo. To make a panorama 

in Lightroom, first you need to import your 

photos into your catalog. Once you have your 

photos, select them in the Filmstrip in the Library 

module, Right-click on one of the selected 

photos, and choose Photo Merge>Panorama. 
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Step Five: I love this option, because 

you can create, crop, retouch, and 

pick your white balance for your 

panorama, all right in Lightroom—

so much easier! Now that you’re 

in the Panorama Merge Preview 

dialog, you can choose the options 

that work best for your photo. For 

this pano, I picked Perspective 

because it’s the only option that 

didn’t distort the horizon. 

Step Six: You could choose Auto 

Crop in the Panorama Merge Preview 

dialog, but you can easily crop the 

photo yourself. After clicking Merge, 

use the Crop Overlay tool (R), and 

crop out all the white and unwanted 

areas of the photo, as shown here. 

Press Enter to commit the crop. 
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Above: Before Basic panel adjustments ; Below: After Basic panel adjustments
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Step Seven: Now that we have a 

nice panoramic RAW file, we can 

start with a basic development: Open 

up the Shadows to +100, lower the 

Highlights to –100, set the Blacks 

to –33, and increase Whites to +45. 

When I started out in photogra-

phy, I added a lot of Clarity to my 

landscapes, but when you do that, it 

looks very unnatural. On this photo, 

I wanted to go for a saturated look, 

because the scene was saturated, 

but I also wanted to keep it look-

ing natural. For that, I lowered the 

Clarity to –20. As the image lacked 

contrast, I boosted the Contrast to 

+37, and added some Vibrance (+36) 

and Saturation (+15). That’s my basic 

development, but it’s already made a 

big difference. 

Step Eight: As you can see, the white 

balance is a bit off. I tried setting the 

white balance to Shade, but that 

didn’t work at all for this example. 

Step Nine: So, I moved the Temp 

slider to 4,513 and the Tint to +10, 

which gave a much nicer look to the 

photo. Now we’re at a great start-

ing point to make this photo look as 

incredible as the actual scene was 

when I was there! 
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Step 10: To re-create the ambience, let’s first remove the ugly sign at the bottom of 

the photo using the Spot Remove tool (Q). Just paint the area that you want Light-

room to remove. This works well in this example because there’s a lot of random 

texture around the sign. 

Step 11: One of my favorite tools in Lightroom is the Graduated Filter (M), and I’m 

going to use several on this photo. I’m not a fan of the texture at the bottom of this 

photo, so I’m going to “close” that area of the photo with three Graduated Filters. 

I applied them on the left, right, and in the middle, and set the Exposure to 

around –0.79 to darken those areas. 
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Step 13: Now that the sun has been re-created and the lower part of the photo is 

“closed,” I can set up Graduated Filters at the top of the photo. I added two: the 

first with a subtle –0.60 Exposure, and a second at the top of the photo to add 

more blue by setting the Temp to –20 and the Exposure to –0.11. 

Step 12: We’re missing the sun that was present at the time; so to re-create the sun, 

I used a Radial Filter (Shift-M). I made a big oval to the right of the photo, clicked on 

Invert, and set the Feather to 100. Then, I boosted the Exposure to 1.75, dragged the 

Saturation to 55, and set the Temp all the way to 100 to get this very yellow look, 

exactly how it was when I was there, to be honest. 
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Step 14: To finish a photo like this, you can do some dodging and burning with 

the Adjustment Brush (K). Set the Flow to around 90, boost the Exposure a bit, 

and just brush parts of the photo to brighten them and make them pop, such 

as the water and parts of the trees in this image. This will make the photo more 

dynamic. Be careful to not go over the top with your adjustments; just paint on 

various parts of the photo to highlight those areas. If you see that your brush is 

too extreme, you can hold the Option (PC: Alt) key and it will become an eraser. 

The final result is below. I hope that you enjoyed these tips and that you get 

amazing sunsets with the pleasure of developing your photos so they look the 

way you remember the scenes when you personally witnessed them. Happy 

shooting, my friends! n

https://photoserge.com/
http://community.kelbyone.com/t/lightroom-magazine-issue-38/
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Now that Lightroom CC has been out for a few months, you 

might be wondering if it’s worth switching over from Light-

room Classic. While we each have to judge this for ourselves, 

I thought it would be helpful to go through the process of 

what you should consider to prepare your Classic catalog for 

migration. Whether you’re planning to make the switch or 

not, many of these tasks could be considered good house-

keeping tips for all Classic users. 

PREPARING A CLASSIC 
CATALOG FOR  
MIGRATION TO CC

Under the Loupe | BY ROB SYLVAN
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If I may editorialize for a moment, at the time of this writing, 

Lightroom CC lacks too many of the features and functions 

I rely on in Classic, so I personally won’t be making the com-

plete switch any time soon. I do like the direction of Light-

room CC, and I do use it in a limited way on my mobile devices 

in sync with my Classic catalog. There may be a point in the 

future where Lightroom CC has added enough key features 

to make me rethink my position, but until that day comes, I’m 

quite content with staying in Classic. Adobe has stated that 

they remain committed to Classic, and indeed, some new fea-

tures and performance improvements have been added in the 

most recent Classic update (see my article on page 20 for 

details). As long as Classic continues to evolve, improve, and 

grow, I may never end up making that switch. 

One more thing: When I use the word “migrate” here, 

I’m talking about the process where you ingest your entire 

Classic catalog into Lightroom CC, and completely transition 

your workflow away from Classic and go full time into CC 

only. Classic and CC just aren’t designed to work together 

on the desktop, and I don’t recommend trying to keep your 

Classic catalog synced with CC after the migration. This is a 

huge step, and not one to be taken lightly. I simply want to 

make you aware of what you need to do in Classic first. 

Preparing Your Classic Catalog 
This is a good time to identify the name of your Classic cata-

log, and where it’s stored on your drive. That way, you don’t 

waste time cleaning up the wrong catalog file, and when/if 

it comes time to migrate to CC, you’ll know where to find it. 

Go to Lightroom (PC: Edit)>Catalog Settings and click on 

the General tab to see the name and location of the open 

catalog. Make a note of that. It’s also a good idea to have a 

backup of your catalog before you do anything else so that 

you can always get back to where you are now. 

One of the first things to do is connect any offline drives, 

and then connect any remaining offline/missing photos that 

the catalog is unable to find. (I’ve written an entire article 
on solving that problem that you may want to file away.) For 

the simple reason that the migration process to CC involves 

copying all of your photos (and videos) to the cloud, you 

need to ensure that there are no missing/offline files in your 

Classic catalog. 

Resolve Metadata Conflicts 
With that done, you should search out and correct any 

metadata conflicts that may exist in your catalog. A meta-

data conflict is a situation where the information stored in 

the Classic catalog is different from the information stored 

in a given photo’s XMP metadata. The most common situ-

ation where this arises is if you work on a photo outside of 

Lightroom, such as applying a keyword in Bridge instead of 

Lightroom, or editing in Camera Raw instead of the 

Develop module. Sometimes Lightroom flags photos as 

having metadata conflicts for no apparent reason, how-

ever, even if you’ve never done anything to your photos 

outside of Lightroom. 

These metadata conflicts usually don’t affect you in Classic  

because the information stored in the catalog is what’s 

primary, regardless of any metadata changes to the photo 

itself. But for the purpose of migration, you’ll need to 

resolve them for good. But first you have to find them, and 

for that, a smart collection can make this easier. 

Step One: Click the + sign on the Collections panel and 

choose Create Smart Collection.  

Step Two: In the Create Smart Collection dialog, give it a 

meaningful name, then click the drop-down menu on the 

first rule, and go to Other Metadata>Metadata Status. 

Step Three: Complete the rule by configuring Metadata 

Status is Conflict Detected. 

Lightroom Magazine
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Step Four: Click the Create button, and this will search 

through your entire catalog and gather any files that meet 

this criteria. In my case, 482 files appeared in that smart 

collection. A photo or video with a metadata conflict will 

display an icon with three lines and an exclamation point in 

the upper-right corner. 

with Overwrite Settings, which tells Lightroom to take the 

information stored in the catalog and write that to the pho-

to’s XMP metadata, overwriting the information that’s there. 

If you know you didn’t do anything outside of Lightroom, 

then this is the way to go; however, if you know you did 

do something to the metadata (like add keywords or make 

edits in Camera Raw) outside of Lightroom and you want 

to replace the metadata information stored in the catalog, 

then you’d choose Import Settings from Disk (do this with 

caution). The end result of either choice is to make the infor-

mation stored in the catalog the same as what’s stored in 

the photo’s XMP metadata. 

Step Five: To resolve the conflict, you’ll need to click that 

icon and make a choice. You can choose to Import Settings 

from Disk or Overwrite Settings. The safest choice is to go 

Step Six: You can select multiple photos in Grid view, click 

the icon on any one of the selected photos, and apply the 

same choice to all the selected photos. Once you’ve resolved 

the conflict on a given photo, it will vanish from the smart 

Lightroom Magazine
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collection because it no longer matches the rule. Keep going 

until the smart collection is empty. 

Classic Features that Don’t Exist in CC 
As I mentioned previously, CC doesn’t (currently) support 

all of the features and functions in Classic. If you’re pre-

paring to make the migration, you’ll need to evaluate 

how important each of these features are to your work-

flow and find a way to work around CC’s limitations, or 

do without them. Keep in mind that the CC of today isn’t 

the CC of tomorrow, and new features are added on a 

regular basis. 

Possibly the most critical limitation to consider is the 

fact that CC doesn’t (currently) support books, prints, slide 

shows or web galleries (made in the Web module), so you’d 

lose the ability to access those in CC. Yes, you can keep 

your un-synced Classic catalog for those jobs if those are 

mission-critical, but then maybe Classic is the better choice 

for you anyway. 

Snapshots to Virtual Copies 
Assuming you’re fine with leaving those creations behind, 

the next feature to consider is snapshots. Within the Develop 

module you have the ability to create snapshots of a given 

edit state, and these are stored in the Snapshots panel. CC 

does not support Snapshots. CC does (sort of) support 

virtual copies, so if there were snapshots you wanted to 

keep, you could create virtual copy versions of them; 

however, that’s a manual process. 

You can employ a smart collection to gather all photos 

that have a snapshot, and then manually go through the 

Snapshots panel of each photo to decide if you wanted to 

keep that state as a virtual copy. 

Step One: Create a smart collection with the rule: Has 

Snapshots is True. 

Step Two: Select the first photo in the smart collection and 

go to the Develop module.

Step Three: Expand the Snapshots panel and evaluate each 

snapshot by clicking each one. 

Step Four: If desired, go to Photo>Create Virtual Copy to 

preserve an active snapshot as a virtual copy. 

Keywords and Color Labels 
Any photos that have had keywords applied in Classic will 

retain those keywords after migration. Lightroom CC doesn’t 

support a hierarchical keyword list structure, however, so 

they’ll become a flat list, which will include any keywords 

you’ve marked not to include on export, such as parent 

keywords only used as part of your hierarchy. There isn’t 

anything you can do about that, but you should know 

before you go. 

In addition, Lightroom CC doesn’t support color labels. 

Any photos in Classic that have a color label applied will see 

that color label change to a keyword after migration to CC. 

For example, a photo with a yellow color label in Classic will 

end up with the keyword “Label_Yellow” in CC. If you’ve 

customized the labels you use in Classic (Metadata>Color 

Label Set>Edit), then you should see your custom words 

appear instead of the default names of the color labels. 

Collections Are King in CC 
Collections form the backbone of the organizational system 

in CC, so you’ll want to spend some time organizing and 

cleaning up your Collections panel in Classic to get off on 

the right foot. Check out my “Under the Loupe” column  

in Issue 28 of Lightroom Magazine for tips on using the 

Collections panel. Note: The panel that displays collections 

in CC on the desktop has a fixed width, so long collection 

names in a multi-level structure can be hard to see. “Nest-

ing,” as multilevel folders and albums are called in CC, are 

also limited to five levels. You can do the same reorganiz-

ing later in CC, but I still think a little tidying up ahead of 

time is a good idea. 

Lightroom Magazine
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As powerful and useful as smart collections are in Classic, 

they’re not supported in CC. If you have any smart collec-

tions that you want to keep in CC, you’ll have to select all the 

photos in the smart collection, and then go to Library>New 

Collection to make it into a regular type of collection. 

An important clarification to make is that all of your 

regular collections will be referred to as “albums” in CC, 

and all of your collection sets in Classic will be referred to 

as “Folders” in CC. 

What About the Folders Panel in Classic? 
When you migrate your catalog to CC, all of the photos in 

that catalog are uploaded to the cloud, and the photos 

stored in the cloud become the master version, as far as CC is 

concerned. The benefit of this is that it allows you to access, 

edit, and output your photos from any device running CC. 

Since all photos are in the cloud, however, your local folder 

structure is meaningless to CC. As such, there will be no ref-

erence to your existing folder structure in CC unless you 

manually create new collections 

based on your Classic folders. 

If you only use a simple 

date-based folder structure to 

store your photos on disk, then 

there really isn’t anything to do 

because CC does have a built-in 

function to display photos based 

on capture date. If you have a 

more customized folder struc-

ture and you want to see that 

structure in CC, you’ll have to 

create new collections based on 

those folders. 

Fortunately, this has gotten 

a lot easier in the 7.2 update to 

Classic that came out in February 

2018. Once you’ve installed the 

update, there are new contextual 

menu choices when you Right-

click a folder in the Folders panel. 

In this example, I’ve Right-clicked 

a parent folder (2017), which 

gives me the option to either Cre-

ate Collection Set “2017” or Cre-

ate Collection “2017” in a con-

textual menu (top next page).

Choosing Create Collection 

Set will open the Create Collec-

tion Set dialog with the folder 

name populating the Name field. 

There’s also the option to include 

this new collection set within an 

existing collection set, if desired. 

Once created, not only will the 

selected parent folder be made 

into a collection set, but any 

subfolders will be added to the 

Lightroom Magazine
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new collection set as regular collections. With this function, 

you could easily re-create your entire folder structure in one 

move by using this option on your top-level parent folder. 

Choosing Create Collection will open the Create Collec-

tion dialog, where you can add that collection to an existing 

collection set and even rename it (if you want). This will cre-

ate a single new collection containing all of the photos in 

that folder (and its subfolders, if applicable). 

You can also drag-and-drop folders down to the Collec-

tions panel to create collections automatically from those 

folders. This won’t re-create the structure using collection sets, 

but it’s fine for direct folder-to-collection conversion. 

Now that you’ve done all that housekeeping, take a 

moment to optimize your catalog via the File>Optimize 

Catalog menu. Once that’s complete, back up this copy of 

the catalog too. 

Closing Thoughts 
Moving forward, you don’t have to go all-in when 

migrating to CC (if you choose to do so). Now that you 

have your catalog in good shape, you might consider 

exporting a smaller catalog from your main catalog,  

and then migrate just the smaller catalog. This will start 

the process and give you a sense of what’s involved. If 

that’s successful, then you can continue to export addi-

tional small catalogs until you’re fully migrated. I have a 

friend who is doing this year by year. Remember that 

you’ll want to disable sync from your main catalog to 

avoid problems. 

Notes: A weird thing about migrating exported catalogs is 

that, after the catalog exports, you have to open it once into 

Classic (then close it) before CC will let you migrate it. Also, 

you can only migrate a catalog once. n
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Some photographers love the sense of realism you get in 

capturing a moment; some love elevating their photos to 

a different place, a work of art, or an illustration, if you will. 

Plug-ins such as ParticleShop help make this change with 

elements of fantasy, but there are other plug-ins that are  

tailored to make specific changes to your photo. Auto FX 

Software’s Mystical FX Gen2 is one on these. 

Mystical FX Gen2:
Landscape FX Pack

Maximum Workf low  |  BY SEAN MCCORMACK

https://members.kelbyone.com/wp-content/uploads/magazines/lrmag/LightroomMagazineIssue34/index.html?page=34


Mystical FX Gen2 is the basic engine to which you add 

different modules to increase the range of effects that you 

can apply to your photos. For this article, we’re looking at 

the newest module, the Landscape FX Pack, and we’ll go 

through the various effects that it offers. There are many 

more packs available, as well as a bundle that contains all 

the modules. 

Install 
The installation of Mystical FX Gen2 is straightforward. Run 

the downloaded file to access the package file, and then 

run the installer. Restart Lightroom after installing. 

As with most plug- 

ins, you get a pre-

set inside the Photo> 

Edit In menu to start 

the app. 

Layout 
The initial layout is quite basic (see image below), but addi-

tional controls are added when you select an AFX Effect 

from the menu in the top toolbar. 

1.  Although blank here, this panel is where you control 

the settings of the AFX Effects, or a selected item from 

the Tools option in the menu. 

2.  The Layer Palette is a moveable panel where any tools 

and effects are stacked. Clicking on a layer opens 

the settings for that layer. Use Delete to remove it, or 

Mask to show any masks used on the selected layer. 

The Opacity control is for the currently selected layer, 

not an overall transparency control. 

3.  The Brush Palette is another moveable palette that 

controls the settings for your masking brush. 

4.  The Menu is where you choose file actions, select tools 

or effects, get help, or change your view options. 

5.  In this toolbar you can preview the original file, use 

the Hand tool to move about, and the Zoom tool to 

zoom in and out. The last icon is for Memory Dots, 

which are essentially snapshots. Click on a dot to 

apply it and again to go back to it. 
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Using Auto FX 
There are quite a variety of looks in Auto FX, and some 

are more suited to particular photos than others, so you’ll 

see a variety of photos used throughout this article. In 

addition to the effects, there are some basic tools in the 

menu, but we’re mainly here to see the looks that the 

plug-in can generate. Click Select AFX Effect to choose 

a particular effect. As well as packs you own, you can 

trial looks from other packs. For this, we’ll stick to the 

Landscape FX Pack, and take a look at its various effects 

and settings. 

Dreamscape 
This effect can create a contrasty look with glowing highlights. 

•  Exposure: Boosts the brightness as per an f-stop 

increase in-camera. 

•  Dreamy: Controls the glow added to highlights. 

•  Infuse Color: Increases color saturation. 

•  Darken: Pulls down the darker areas more, increasing 

shadow contrast. 

•  Contrast Tones: A contrast slider centered on midtones. 

•  Deepen: Adds contrast from midtones to highlights. 

•  HDR Tones: Expands the dynamic range. 

•  Enrich: Controls the darkness in the image. 

•  Tonal Depth: Compresses the effect of the contrast— 

a neat control. 

•  Lighten: This opens up the shadow area, often 

required because there’s so much “add black” in  

the other settings. 

Before

After
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Before

After

Dreary Snow 
This effect mutes the scene with the addition 

of snow. 

•  Size: Controls the size of the flakes. 

Flake patterns are quite visible at  

larger sizes. 

•  Items: Determines how many different 

bits of snow you get. 

•  Size Variation: Lower values have 

only smaller-sized particles; higher 

values have a wider variety of sizes. 

•  Saturation: In this effect, Saturation  

is about the removal of color, muting 

the photo. 

•  Whiten: Adds white to the photo to 

make it look like a whirl of snow is 

over the scene. 

Dusty Trail
This effect creates a dust trail for your photos. 

You need to use the + Brush in the Dusty Trail 

panel to add this to your photo. 

•  Color: Use the swatch to select the 

dust color, and the slider to set the 

opacity. The default yellow looks like 

dust, but white makes it look more 

like mist or fog. 

•  Softness: Controls the feather of the 

dust effect. 

•  Density: Thickens or thins the effect. 

•  Variation: This randomizes the place-

ment of the effect, giving more options 

on the look. 
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Golden Hour 
This effect adds flare and warmth. Along with the 

brush options, you can move and rotate the lens flare. 

•  Select Lens Flare: I’m guessing this is meant 

to load different flares, but honestly nothing 

changed for me. 

•  Flip Horizontally: Changes the direction of the 

flare to better suit your photo. 

•  Flare Opacity: Changes the 

strength of the flare. 

•  Softness: Adds a glow  

to the photo. 

•  Dark Mood: Darkens  

the photo. 

•  Warmth: Sets the color  

and opacity of the color  

cast on the photo. 

Monochrome 
This effect allows you to create toned black-and-

white photos. 

•  Active Color: This is your tone color, selected 

via the color tiles for ease, or by clicking on the 

swatch to select from a Color Picker. The slider 

varies the strength. 

•  Filter Type: Choose from a 

range of filter emulations: 

Normal, Red, Orange, Yel-

low, Green, or Blue. 

•  Enrich: The black control 

for creating richer blacks. 

•  Deepen: Contrast for mid-

tones to highlights. 

•  Sharpen: Brings out the 

detail in the photo. 

•  Levels tool (histogram): Use this to set the 

black and white points. Moving the center 

point changes the gamma, making it more or 

less contrasty. 

•  Contrast: Decrease to make a flatter gray 

image, or increase for a richer image. 
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•  Opacity: Decrease to bring back the  

original image. 

•  Ellipse: There’s an Ellipse option to create  

a radial area where the effect doesn’t show. 

You could use this to create a black-and-white 

border for a color photo. 

Moving Water
This effect creates the look of slowing down the expo-

sure when capturing moving water for a more silky 

appearance or streaks. Use the brushes to control 

where it affects. 

•  Opacity: Controls strength of the streak. 

•  Softness/Distance: The distance the streaks 

are from their source. 

•  Streak Amount: The cast of the streak. 

•  Tonal Range: Chooses what tones in the image 

are used to generate the streaks. 

•  Soften Streak: Feathers the streaks. 

•  Streak Direction: Changes the direction  

of the streak. 

Night Time 
This effect changes day for night toning. 

•  Apply: Global means it’s applied to the whole 

image. Use the – Brush if you want to remove 

the effect from specific areas. You can use the 

Ellipse tool on this as well. 

•  Dark Mood: Controls the nighttime feel. 

•  Softness: Gives a glow. 

•  Dark Tint: Adds the blue color to the scene. 
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Starry Night
This effect adds stars to your skies. 

•  Use the Lasso tool to remove stars. 

•  Color: Sets the base color and strength. 

•  Size: Sets the base size. 

•  Items: Determines the number of stars in  

the shot. 

•  Color Variation: Set higher for a greater  

number of colors. 

•  Size Variation: Set higher for a greater  

variety of star sizes. 

Star Trails
I think this one is obvious! The settings are similar to 

Starry Night but there are a few tricks to this one. 

•  Set the center of the trails using the target icon. 

•  Next, use the Lasso to remove the stars from 

foreground, etc.

•  The Lasso Palette will 

be active where you can 

change the Spread and 

Opacity of the lassoed area. 

•  Color: Sets the base color 

and strength. 

•   Size: Sets the base size. 

•  Items: Determines the number of star trails in 

the shot. 

•  Color Variation: Set higher for a greater num-

ber of colors. 

•  Size Variation: Set higher for a greater variety 

of star sizes. 

•  Distance: The length of the trail. 
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Vintage Color
The final effect creates an effective retro look for your 

photo. The whole photo is affected with Apply:Global, 

so use one of the available tools to remove parts of the 

effect if needed. You also have textures available via 

the mask-and-double page icon in the panel.

•   Opacity: Controls the strength of the effect. 

•  Enrich: Controls the darkness in the image. 

•  Deepen: Adds depth and contrast. 

•  Grain: Adds a filmic grain to the photo. 

•  Sharpen: Sharpens edges. 

Horses for Courses
There are a whole range of packs that can be added to 

Mystical FX Gen2, and you can even trial them through 

the app before you buy them. There are some neat 

looks in the Landscape FX Pack—I especially like Dusty 

Trail for creating mist, as well as the Dreary Snow and 

Starry Night effects. You may not have a use for all 

of the effects, but any tool that includes at least a few 

useful effects is worth having around! n
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“I hate HDR.” Do a Google search on that topic and you’ll find tons 

of examples of poorly processed HDR (high-dynamic range) im-

ages—images with haloes, images that look oversaturated with 

exaggerated details, and images that look grotesquely grungy. 

Do a Google search on “I love HDR,” and you’ll find images that 

don’t look like HDR images—images with a natural look. 

HDR FOR  
ENVIRONMENTAL  
PEOPLE PICTURES? 
GIVE IT A TRY!

Photography Secrets  |  BY RICK SAMMON
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The key to a good HDR image, especially one with a  

person in it, is to make it look as if it weren’t several  

exposures processed in an HDR program. Before we get 

going, this isn’t a detailed article about processing HDR 

images; it’s about how to get a set of exposures for  

environmental people images (pictures that show a  

person in his or her environment) to be processed in an 

HDR program, with a few processing tips included. 

Keep in mind that as new versions of Photoshop 

and Lightroom are released, and as the dynamic range  

of image sensors increases, there will be less need for  

HDR, because so much detail can be pulled out of the 

shadow and highlight areas of a single file. HDR is needed, 

however, when shooting in a very high-contrast situation: 

the higher the contrast range, the more images you need 

to capture the dynamic range of the scene. 

One more thing before we begin: HDR isn’t recom-

mended (or needed) for headshots and studio shots 

where the contrast range can be controlled, and perhaps 

more importantly, where HDR can, if used incorrectly, 

make the subject look worse. 

Okay, let’s take a look at the process! 

Getting Natural Skin Tones 
The image that opens this article is one of my favorite HDR 

environmental people images, mostly because the skin tones 

look natural. HDR was needed to capture the outside scene as 

well as all the details of the room. 

Here are the three RAW files I used to create my HDR 

image. The exposure settings were: EV 0, EV –2, and EV +2. 

My camera was on a tripod and I used the camera’s self-

timer to release the shutter. Before I took the set of images, 

I asked the model to hold very still. 

I used Aurora HDR 2018 from Skylum (formerly Mac-

phun) to process the set of images. This screen grab reveals 

an important piece of information: I’m using a Realistic HDR 

preset in Aurora. The idea here is that no matter which HDR 

program you use, you want to choose a Realistic preset so 

you get natural skin tones in people pictures. 

https://aurorahdr.com/
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If you still get “funky” skin tones, there’s still hope for 

natural-looking skin. After you create your HDR image, open 

it in Photoshop. Then open the original exposure that has 

the most natural-looking skin tones, and use the Move tool 

(V) with the Shift key held down to drag it into the HDR 

image. With the HDR-processed image as the top layer, use 

the Eraser tool (E) set to Brush in the Options Bar to erase 

the skin area so you can “see through” to that area of the 

image below. When you’re finished erasing, flatten the file 

for your final image. 

To create the file, I set the exposure compensation to EV 

0, EV –2, and EV +2, and I chose the Art Vivid mode to 

enhance the color in the scene. I’ve found that using EV 0, 

EV –1, and EV +1 isn’t much of an advantage, as you can 

already pull out that much information from a RAW file. In 

addition, when using EV 0, EV –3, and EV +3, some data can 

be missing from the in-camera HDR files, because the range 

between 0 and 3 is too wide. 

HDR programs, and the HDR features of Photoshop and 

Lightroom, offer Remove Ghosts or De-Ghosting features. 

Before you set your HDR processing in motion, be sure to 

select this feature, as it will help to avoid ghosts (anything 

that moved between frames), which look as though you’re 

seeing double. 

As a final processing step, I added a warm glow to my 

image by applying the Duplex filter in Nik Color Efex Pro. 

In-Camera HDR 
Some cameras, including the Canon EOS 5D Mark IV, offer 

in-camera HDR. Some of these cameras save all the RAW 

files and produce a JPEG HDR, while others, usually less-

expensive models, only produce a JPEG HDR from three files. 

This image of stick fishermen in Sri Lanka is a Canon 5D 

Mark IV in-camera HDR. I needed HDR to capture detail in 

the area surrounding the sun and in the waves. 
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In-camera HDR is good and cool, but you 

can usually pull out more information, and 

be a bit more creative, when using HDR pro-

grams such as Aurora, Photomatix, or HDR 
Efex Pro. That said, my Sri Lanka in-camera 

HDR image is one of my favorite HDR images. 

In fact, I used it on the cover of my 37th book, 

Exploring Photographic Exposure. 

Using More Exposures 
As the contrast range of a scene increases, so 

does the number of shots needed to capture 

the dynamic range. Above is an HDR image  

I took of my friend, Spike, in San Antonio, 

New Mexico, not too far from Bosque del 

Apache, New Mexico, where we shot some of 

my bird photography class for KelbyOne. 

To capture the dynamic range of the scene, 

I set my camera for a seven f-stop automatic 

exposure bracketing sequence. The result 

is that you can see inside and outside of the 

car—even though I was shooting into the sun. 

https://www.hdrsoft.com/
https://www.google.com/nikcollection/products/hdr-efex-pro/
https://www.google.com/nikcollection/products/hdr-efex-pro/
https://www.amazon.com/Rick-Sammons-Exploring-Photographic-Exposure/dp/1138096113/ref=sr_1_3?s=books&ie=UTF8&qid=1518462330&sr=1-3
https://members.kelbyone.com/course/rsammon-breathtaking-bird-photography/
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I used my Canon 15mm lens for the handheld image. 

Note that the wider the lens, the better chance you have 

of your HDR program aligning the images, because there’s 

less apparent camera movement between the exposures. 

My Sri Lanka image is also a handheld shot. 

It’s also important to watch (and 

listen to) your shutter speed when 

taking hand-held shots for an HDR 

sequence. The slower the shutter 

speeds between exposures, the more 

camera movement there is between 

the exposures. As a general guide-

line, when taking a handheld HDR 

sequence, check the EXIF info on your 

camera’s LCD to make sure the shut-

ter speed on the most underexposed 

image isn’t below 1/125. 

Above is a shot of Robert Randazzo 

in his Absolutely Neon shop in Albu-

querque, New Mexico. Again, HDR 

was needed to capture the detail in the 

signs and the walls—and on Robert. 

After doing some tests to see how 

much over and under the average 

exposure was needed to capture the details in the 

scene, I set my camera on a tripod for an eight f-stop 

exposure sequence. I set my lens at 17mm. I processed 

the files in Photomatix for one of my favorite images 

from Route 66. 
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Other Color Issues
Here’s a favorite image from one of my 

South Florida photo workshops. It was 

taken in the Colony Hotel in Delray 

Beach—one of the coolest hotels I’ve 

stayed in, by the way. 

To capture the detail on the walls and 

the model, five exposures were needed. 

After processing the image in Photo-

matix, I noticed that the model’s face was 

too red, the result of the red wall reflect-

ing color at her. To reduce that effect,  

I used the Sponge tool (nested under the 

Dodge and Burn tools [O] in the Tool-

bar) in Photo shop, selected Desaturate in 

the Mode menu in the Options Bar, and 

painted over her face. 

Speaking of color, chromatic aberrations 

can creep into HDR images. As the number 

of images increases, so do the chromatic 

aberrations—usually. Same with noise: as 

the number of images increases, so can 

noise in an image. Before you share or post 

an HDR image, check for chromatic aberra-

tions and noise, and reduce them accord-

ingly in Photoshop or Lightroom. 

Well my friends, I hope this article has 

inspired you to say, “I love HDR.” If it’s used 

properly, it can be an artistic tool when 

making environmental people pictures. n
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Questions & Answers
Q.  How come when I choose a preset, the results 

can sometimes look different? For example, when 

I’m trying out different presets and I come to my 

favorite one, when I apply it, it looks completely 

different than it usually does, even if it’s on a 

photo taken in the same light at the same time. 

Why would this happen? 

A.  It’s because presets just move your sliders to prede-

termined locations, and if you click on a preset, and 

then click on a different preset (in this case, your favor-

ite preset), there’s probably a slider or two that was 

moved in the previous preset that’s still in place when 

you applied your favorite preset. 

   Take a look at the Basic panel shown here after  

I applied one of my presets. Note the Temp and Tint 

settings. In the second Basic panel (the one on the 

Q.  I’ve heard that you can move the edit pins for  

the Adjustment Brush, and that people think it’s 

a really cool thing. I guess if you painted with the 

Adjustment Brush and somehow missed the area 

you wanted, dragging it to the right area might 

be helpful, but I’ve never really needed to do that, 

and can’t imagine that happens to anyone very 

often. Am I missing something? Is there more to  

it that I don’t realize? 

A.  Let’s say you brightened your subject’s face in one 

photo using the Adjustment Brush (K), and then you 

copied-and-pasted that adjustment to another similar 

photo (or you had Auto Sync on, or used the Previous 

button to paste those settings to a new photo), but in 

that second photo, the subject moved her head (which, 

of course, is very common between photos). That facial 

brightening will be off by either a little or a lot due 

to her head movement. (Look at the images below 

where I left the red mask visible, and you can see what 

I mean—the brightening from the original image is off 

to the right in the second photo where I pasted the 

edits.) Being able to drag a pin lets you fix the position 

of the Adjustment Brush in other photos without hav-

ing to redo it from scratch.

right), I clicked on an entirely different preset, but it kept 

the Temp and Tint amounts from the previous preset. 

That’s because the preset I just applied didn’t change 

the Temp and Tint settings. So, what you wind up with 

is part of the previous preset and part of your favorite, 

so it doesn’t look like what you’re used to seeing with 

that preset. The solution? After you apply a preset, hit 

the Reset button before you apply your favorite preset—

that way, the only sliders that are affected are the ones 

in your favorite preset (and it doesn’t pick up any sliders 

from the previous preset). 
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Q.  I don’t use collections in my Lightroom work (I’ve 

been organizing everything in folders since I started 

years ago), and I’m considering using Lightroom 

mobile on my iPhone [Ed Note: Lightroom mobile 

has been renamed “Lightroom CC”], but I’ve been 

told it doesn’t work with folders. When I see screen 

captures of Lightroom mobile [CC], however, I can 

see it does use folders, but I can’t get mobile to 

recognize my folders. Do I need to change some-

thing, or turn on something?

A.  Actually, there are two issues here: First, Lightroom CC 

on your mobile device can’t actually sync folders from 

Lightroom Classic; it only syncs collections. The second 

issue is that Adobe has renamed collections in Light-

room CC—they’re now called “Albums” on your mobile 

device, and what you’re seeing there named “Folders” 

used to be collection sets (that’s where you organize your 

collections). Adobe just changed the name there as well. 

   Luckily, thanks to the new 7.2 release of Lightroom 

Classic, converting your folders in Lightroom Classic to 

collections (that you can sync to mobile) is incredibly 

easy. Right-click on any folder and choose Create Col-

lection to turn that folder into a collection. If it’s a 

folder with other nested folders inside it, Right-click 

Q.  A lot of times when I’m shooting tethered in  

Lightroom, it just stops bringing images into  

Lightroom. I can usually get it back up and running, 

but from what I’ve read, this happens to a lot of 

people. Am I doing something wrong, or is this 

just how it works? 

A.  Sadly, that’s just how it works, and from what I’ve read 

online, it’s not going to get any better anytime soon 

(and yes, it’s always been like this). So instead of wait-

ing for a fix that may never come, just get good at 

troubleshooting the tethering feature (which has been 

in Lightroom since version 1.0, I believe—version 2.0 at 

the latest). Anyway, first make sure your camera hasn’t 

gone to sleep (to save the battery), then try restarting 

the tethering (turn it on/off) right in Lightroom. If that 

doesn’t work, try unplugging and plugging the tether-

ing cable. If that doesn’t work, restart Lightroom. One of 

those (in that order) will probably work. 

Q.  There are some Lightroom modules that I just  

never use at all, such as the Web, Map, and Slide-

show modules. Is there a way to disable them so  

I don’t have to even see them? 

A.  Well, there’s a way to hide them? Does that count? :-) 

Here’s what to do: Go up the to Module Picker panel 

across the top (where it says Library, Develop, etc.), 

Right-click in an empty space, and a pop-up menu will 

appear. All the modules will have checkmarks next to 

them—just uncheck any module you want to hide. In 

the example shown here, I unchecked the Web module, 

and you can see that it no longer appears in the Module 

Picker along the top—it ends with Print. 

on that top-level folder and choose Create Collection 

Set, and it will keep those nested folders intact as a 

collection set. Now you can sync those collections to 

Lightroom CC on mobile. 
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Q.  I’m considering giving Lightroom CC (the cloud-

storage version of Lightroom) a go, but what if  

I don’t like it, or it doesn’t suit my needs (I know  

it has a lot less features)? Is there a way I can get  

my photos back from the cloud easily? 

A.  There is. Adobe has released a free app called the 

“Adobe Lightroom Downloader,” which is a cloud- 

photo-downloader for just that purpose. So, if you 

change your mind, or end your subscription, with just a 

click or two, you can download all your images stored 

in Adobe’s Cloud straight to your computer or external 

hard drive. I’ve tested it, and it works really well. You 

can download it here. Also, it’s my understanding that 

Adobe gives you a full year after the end of your sub-

scription to download those images (before they delete 

them), so unless you have the procrastination habits of 

a teen boy, you should be covered. ;-) 

Q.  I’d like to use the Library module’s Quick 

Develop panel more often, but it’s so limiting 

because it’s missing some key controls, such  

as Saturation. Does Adobe have any plans to  

add those missing ones? 

A.  They do. Well, they did. Well, I guess I should say, 

“They already did.” Those missing controls are just 

hidden. First, make sure you’re seeing all the avail-

able controls in the Quick Develop panel by clicking 

on the black left-facing triangles to the right of each 

section. This will reveal more controls such as High-

lights, Shadows, Whites, Blacks, etc. (as shown in 

the first two images below). But that’s just the first 

step. To see the other hidden controls (like Satu-

ration), just hold the Option (PC: Alt) key, and the 

Clarity and Vibrance controls change to Sharpening 

and Saturation (see the final image below). n
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Tips & Tricks
This issue we’ll take a closer look at “round-tripping” 

images to Photoshop and back for both Lightroom Classic 

CC and the new kid on the block in the Lightroom ecosys-

tem, the cloud-based Lightroom CC. 

Lightroom Classic CC: To Photoshop & 
Back with RAW Files 
When you open a RAW file from Lightroom Classic to 

Photoshop using the Photo>Edit In>Edit in Adobe Pho-

toshop command (Command-E [PC: Ctrl-E]), Lightroom 

will apply any adjustments you’ve added in the Develop 

module and render the RAW image into Photoshop as a 

new file. 

The file in Photoshop will have the resolution, bit depth, 

and color space you’ve specified in the External Editing tab 

of Lightroom (PC: Edit)>Preferences. After editing the file 

in Photoshop and saving it (using the normal File>Save 

menu command, or Command-S [PC: Ctrl-S] shortcut), 

it will be saved in the file format specified in this dialog, 

placed back into the same folder as the original RAW file, 

and added to the catalog. (There’s also an option in the 

External Editing Preferences to stack this edited file with 

the original.) 

ences configured). If you want to bring it (or any non-

RAW file) into Photoshop for further edits, you’re faced 

with a fork-in-the-road situation in terms of Lightroom 

edits and Photoshop edits. The main thing to understand 

is that there are some limitations to how the Photoshop 

edits (especially layers) and any new Lightroom edits can 

work together. 

Opening a PSD, TIFF, or JPEG file  
into Photoshop 
When you choose to open a non-RAW file (i.e., a TIFF, 

PSD, or JPEG) into Photoshop using the Command-E (PC: 

Ctrl-E) shortcut, a dialog appears that asks you what you 

want to edit, and it offers you three options. Let’s take 

a look at each of these options and deconstruct exactly 

what happens. 

•  Edit a Copy with Lightroom Adjustments: This will 

create a new file and include any Lightroom adjust-

ments you’ve added. If the file had layers, however, 

these will be flattened in this new copy (though 

they will still be preserved in the original Photoshop-

edited file). The loss of Photoshop layers makes this 

option a non-starter for me most of the time, but it 

might be useful in some workflows. 

•  Edit a Copy: Creates a copy of the file, but any Light-

room adjustments won’t be applied to the copy. If 

it’s a layered PSD or TIFF file, then your layers will be 

preserved and editable. 

•  Edit Original: The term “original” here is a bit prob-

lematic. Most people think it refers to the original 

Return to Photoshop for Further Edits 
Once a RAW file from Lightroom has been edited in 

Photoshop, it’s now a new file (typically a PSD or a TIFF, 

depending on how you have your External Editing Prefer-

SEÁN DUGGAN
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file that the camera created, but this isn’t necessar-

ily the case, especially with a RAW file. It refers to 

the original file that was created during the first trip 

into Photoshop, or to an original JPEG (possibly a 

camera original, but possibly not), TIFF, or PSD file. 

Any layers that were already present in the file will 

be preserved. 

 JPEG Note: If you open a JPEG file into Photoshop, 

using either the Edit a Copy or Edit Original choices, 

and you add layers in Photoshop, when you close the 

file, you’ll see the Save As dialog instead of the regular 

Save prompt. This is because the JPEG format of the 

original image doesn’t support layers. In the Save As 

dialog, the specified location where the file will be saved 

should be the same folder as the original image (but 

it’s always good to double-check this). After saving the 

file, return to Lightroom, Right-click on the folder in the 

Folders panel, and choose Synchronize Folder to add 

the new, layered version of the image to the catalog. 

Reapplying Lightroom Adjustments  
to Files Edited in Photoshop 
When you open a non-RAW file (i.e., a TIFF, PSD, or JPEG) 

into Photoshop using either the Edit a Copy or Edit Origi-

nal choices, any Lightroom adjustments don’t appear in 

Photoshop and will be removed once the file is saved 

and returned to Lightroom. Here’s a quick way to reapply 

those Lightroom adjustments: 

•  For Files Opened with the Edit a Copy Option: Find 

the original file from which the copy was created 

(the one with the Lightroom adjustments you 

want). Select it and then Command-click (PC: Ctrl-

click) to select the new Photoshop-edited copy. In 

the Develop module, choose Sync (in the Library 

module choose Sync Settings). 

You can also Right-click on the thumbnail of the 

adjusted file and choose Develop Settings>Copy 

Settings, click the Check All button in the dialog that 

appears, and choose Copy. Then Right-click on the 

new copy saved from Photoshop and use the same 

contextual menu to choose Paste Settings. 

•  For Files Opened with the Edit Original Option: After 

saving the edited original file in Photoshop, return 

to Lightroom and go to the History panel on the 

left side of the Develop module. Click on the most 

recent state (the top one) to reapply the Lightroom 

adjustments that were in place before you edited the 

file in Photoshop. 

Alternate Paths into Photoshop 
Depending on what you want to do with your file, there 

are a few other choices available in the Photo>Edit In menu. 

•  Open as Smart Object in Photoshop will do just that, 

extending all the nondestructive flexibility of smart 

objects (far too numerous to list here) to the file 

when it arrives in Photoshop. If it’s a RAW file, you’ll 

be able to re-edit any Lightroom Develop adjust-

ments by double-clicking the smart object layer 

thumbnail and opening the embedded RAW file into 

Adobe Camera Raw. 

•  Open as Layers in Photoshop is for opening multiple 

files as layers into one document. This is ideal for 

when you want to create a multi-image composite 

and have Lightroom and Photoshop do the basic 

layer setup for you. 

•  There are also options for Merge to Panorama in 

Photoshop and Merge to HDR Pro in Photoshop. 

Lightroom CC also offers its own commands for 

panoramas and HDR that don’t require Photoshop, 

and you can find those under Photo>Photo Merge. 

Lightroom Magazine



L
IG

H
T

R
O

O
M

 M
A

G
A

Z
IN

E
 ›

 I
S

S
U

E
 3

8

66

Lightroom CC to Photoshop 
There are a few ways to open a file from the cloud-based 

Lightroom CC into Photoshop. You can use the same 

shortcut for this as in Lightroom Classic: Command-E 

(PC: Ctrl-E). You can choose File>Edit in Photoshop, or 

with the Develop controls open, click the three dots on 

the right side and choose Edit in Photoshop. You can also 

Right-click on a thumbnail and find this option in the con-

textual menu. 

When you initiate a trip into Photoshop for the first time, 

a prompt will appear detailing what you need to do to save 

the file so it appears back in your Lightroom CC catalog. 

An important point here is that Lightroom CC needs 

to stay open in the background, and when you close the 

file in Photoshop, be sure to save it (regular Save, not Save 

As). Another important point, which we’ll look at in more 

detail later, is that “your file’s layers will be preserved as 

long as no edits are made in Lightroom CC.” 

How Smart Previews Can Impact  
Photoshop Edits 
The big difference with Lightroom CC is that the original 

files are, for the most part, stored in the cloud, with a 

smart preview stored locally. When a file is opened into 

Photoshop from Lightroom CC, the original file that’s 

stored in the cloud will be downloaded and then sent to 

Photoshop. Depending on the speed of your Internet con-

nection, and the local sync status, this could result in a 

delay when you try to open a file into Photoshop. 

If there’s no Internet connection, the locally stored smart 

preview will be opened into Photoshop. Since a smart pre-

view isn’t the full size of the original file, it means that 

any Photoshop edits you apply are being made to a much 

smaller version of the image (for instance, a 4032x3024 

original from my iPhone opens at 2560x1920). Depending 

on the type of work you’re doing, this could be a big deal, 

and might require that the Photoshop edits be reapplied 

once you’re able to connect to the Internet and download 

the original file. 

Check the Original vs. Smart Preview 
Status of Files 
In Lightroom CC, click on a file to select it and then click 

the small “i” in the lower-right corner of the interface to 

show the Info for that file. The Sync Status is at the bottom 

of the column on the right, showing what’s backed up to 

the Cloud, and what’s stored locally. Most of the time a 

smart preview will be stored locally, though in some cases, 

you may see that this status is pending. If the original file is 

stored locally, it will show this. You can also choose “Store 

Original Locally” and it will be downloaded to your local 

hard drive. Using this option could be useful if you know 

you’ll need to work on certain files and expect to be with-

out a reliable Internet connection in the near future. 

ALL IMAGES BY SEÁN DUGGAN

Lightroom CC to Photoshop: Bit Depth 
and Color Space 
When a file is sent to Photoshop from Lightroom CC, it 

arrives in Photoshop as a 16-bit TIFF file in the ProPhoto 

RGB color space. This is true for all types of files, even 

if the original was an 8-bit JPEG from your phone. This 

is an odd workflow choice, particularly for JPEGs from 

camera phones, since ProPhoto RGB is more ideally 
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suited to 16-bit RAW originals, and not 8-bit JPEGs. 

Hopefully, we’ll see some control over this in a future 

update to Lightroom CC. 

Lightroom CC: Photoshop Edited Files 
are Stacked with Original 
Once you’ve made your edits in Photoshop, close the file 

and save it. It will appear in Lightroom CC grouped in a 

stack with the original file. Click the number badge in the 

upper-right corner to show a filmstrip view of the images 

in the stack. 

CC adjustments into Photoshop, but there are ways to 

recover your layers. First, in Photoshop, close the file and 

do not save it. By clicking on the three dots in the Edit 

screen, there’s a command to Revert to Original, but this 

will not restore your layers, so don’t rely on it for this. 

Instead, use the Undo command (Command-Z [PC: 

Ctrl-Z]) multiple times to get back to the point before 

you applied any Lightroom CC adjustments to the file 

(this only works if you haven’t closed the Lightroom CC 

program). Then you can re-open the file into Photoshop 

and your layers will be there. Ideally, there should be a 

command in Lightroom CC to remove Lightroom adjust-

ments and restore to the last saved layered version from 

Photoshop. Hopefully, we’ll see something like this in 

the future or, even better, Edit in Photoshop options like 

we have in Lightroom Classic. 

Using Copy Files to Combine Lightroom 
CC Adjustments and Layers 
If you do want to be able to apply Lightroom CC adjust-

ments and keep your layers, here’s a possible workaround. 

Right-click on the photo and choose Make a Copy. If you’re 

viewing a stack, you need to be in the Detail (D) or Edit (E) 

views, or click on a thumbnail in the stack Filmstrip view. 

Use this copy file to apply Lightroom adjustments to 

the image. If you’re happy with the way the image looks, 

you can then export a version from this copy using the 

File>Save To command. Or, if you find you need to make 

adjustments to the layered version of the file, open that 

into Photoshop, make your changes, close, and save. 

Then make a new copy of the revised layered file in 

Lightroom CC. Click on the first copy with Lightroom 

adjustments and in the Edit view, click the three dots on 

the right side and choose Copy Edit Settings. Then make 

the latest copy active and, in the same menu, choose 

Paste Edit Settings. n

Re-Editing Photoshop Files with  
Lightroom Adjustments 
One significant difference between Lightroom CC and 

Lightroom Classic is that when you re-open a Photoshop-

edited file back into Photoshop, you don’t have any 

options that govern how Lightroom adjustments or Pho-

toshop edits are treated (see the first part of this article). 

This is critical because if you’ve added layers to a file in 

Photoshop and then later applied adjustments in Light-

room CC, the layers will be flattened when you bring the 

file back into Photoshop. This is very confusing if you’re 

not expecting it, and all the more so since there’s no 

warning that this will happen (apart from the one men-

tion of this behavior in the initial message that appears 

when you first send a file to Photoshop). 

Salvaging Lightroom CC Files with Acci-
dentally Flattened Layers 
There’s no obvious single undo for restoring layers that 

were flattened by opening a layered file with Lightroom 
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